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Abstract 

From past times oral literature had been the norm for the transmission of folktales. Time 

came when scholars from Nigeria and Igbo Society in particular came to academic 

recognition of the latent potentials in folktales. With that, a lot of oral literature were 

researched on and written down. Thus this led to various publications on the Igbo folktales. 

During the heydays of contemporary Nigerian artists, art scholars like Uche Okeke, Chike 

Aniakor, and Obiora Udechukwu, to mention a few, used visual metaphors to portray some of 

the Igbo folklore, particularly in the form of Uli lines. Today, digital media in Nigeria is not 

farfetched. However, much experiments and visual expressions of Igbo folklore have not been 

explored using these modern digital media. In view of this, this study uses Adobe Photoshop 

CS4, a digital draw and paint tool, to illustrate some of the notable folktales in Igbo oral 

tradition. Vector and Raster techniques of computer graphics will be employed and 

discussed. Basic information on digital illustration will also be enumerated in the project. 

This piece of information will be useful to art Scholars, art teachers and art practitioners at 

large who intend to develop their potentials in illustration technique. 

 

 

 

INTRODUCTION 

Illustration is a pictorial material appearing with a text, which amplifies or enhances 

it. Although illustrations may be maps, charts, diagrams or decorative elements, they are 

more usually representation of scenes, people or objects related in some manner – directly, 

indirectly or symbolically, to the text they accompany. Thus Digital illustration is the use of 

tools from computer software to create illustrations. Every tool like pencil, art brush, 

hairbrush, eraser, atomizer, ruler, layout, and filter effects, to mention a few, are represented 

digitally in illustration software.  

Oral literature had been the norm for transmission of Igbo folklore until many Igbo 

scholars researched and wrote many of them down. Artists used various traditional media to 

express these stories in visual form. This essay employs digital media to create visual 

metaphor of one of the popular folk stories. The study is presenting in visual form, selected 

Igbo folklore, using digital illustration techniques. Adobe Photoshop Cs4 is the software of 

focus for the creation of these illustrations. The study will capitalize on „draw and paint 

techniques‟ and „vector techniques‟. Folklore for exploration will be selected from 

Ikechukwu Okodo‟s collections. 

 

Digital Illustration 

Brower and Everett in wisegeek.com (2009) describe digital illustration as “technique 

of using a computer to provide original artwork.” It is understandable that digital illustration 

is simply computer illustration or digital drawing and painting. This is possible with the help 

of the Graphical user Interface, alongside the hardware devices. Brower et al in 

wisegeek.com (2009) also add that: 
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Digital illustration uses a combination of illustration software and image 

editing software to create computer art. Digital illustration is not merely 

the manipulation of images with software, it is the actual creation of new 

art with digital tools. 

 

Creativity in this new art technique is of utmost importance as some people view that 

personal computer makes graphics too comfortable and cheap. Some also believe that 

computer works everything automatically, and with that, they disregard the creative efforts of 

the artists, who work time after time using the provided hardware and software components 

of the system to produce beautiful images. That, in its entirety is wrong. It is not only a 

question of providing all the hardware and software needed for digital drawing and painting, 

it is a question of what the artist can create with the tools. “A creative person is one who can 

process in new ways the information directly at hand with the ordinary sensory data available 

to us. A writer needs words, a musician needs notes and an artist needs some knowledge of 

the techniques of their crafts” (Edwards 1989). This in relation to digital drawing implies that 

if the artist should come out with outstanding designs when equipped adequately, he has to be 

the master of his tools, in addition to his creative abilities. Creative ideas are of utmost 

importance as the tools for creativity themselves.  

In wikipedia.org (2011), Digital illustration is described as “The use of digital tools to 

produce images under the direct manipulation of the artist, usually through a pointing device 

such as a tablet or a mouse.” Digital tools were pinpointed here as the means whereby artists 

create beautiful images on the digital layout. Traditionally, artists use rulers, pencils, inks, 

brushes and various categories of colours on paper or canvas to create illustrations. However, 

since the Graphical User interface made its debut in the historical development of computers 

in the 80s, the traditional tools were represented by digital tools on the user interface for 

creation of illustration. Even the white paper or canvas is represented on the computer screen 

as digital layout, where art can be created with the digital tools. Traditionally, the layout is 

usually paper smeared with water and mounted on board with paper tape fixed to the edges, 

clothe or canvas stretched on wood and primed with emulsion, top bond or with other 

synthesis. Between the traditional tools, there are similarities and differences as well. One big 

difference between the two is time. Time and speed of production have created wide chasm 

between traditional and digital tools and means of illustration. Not only that, another big 

advantage of working with digital tools on digital layout is that several errors can be undone, 

using the “Ctrl + Z” key or “Ctrl + Alt + Z” key in Adobe Photoshop. This creates chances 

of experimenting with several special tools provided to achieve creative results. On the other 

hand, correcting errors while working with pastels, inks, poster colours and brushes on flat 

surfaces could be tasking. It involves tedious erasure of pigments with synthesis and 

reapplication of required colours on the same spot.  

 

Types of Computer Graphics 

Generally, Computer graphics are made up of three types. One is known as vector, the 

other one is called bitmap or raster while the third is 3Dimensional graphics. However, our 

study is based on raster and bitmap graphics. Their basic characteristics are explained 

hereunder. 

 

Vectors 

Vector graphics is associated with the use of geometrics like lines, points and 

polygons, Beziers, and so on, to create digital shapes. Vectors are dependent on mathematical 

equations which were used to create the programs. Lea (2007) in his opinion, hints: 
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Vectors are mathematical objects that define shapes or curves. Unlike 

pixels, vectors are resolution independent. This means that they can be 

scaled to any size, edited or transformed to infinite amount of times 

without any deterioration of clarity or loss of detail. In Photoshop, vector 

art can be integrated into your image files in the form of paths, vector 

masks or shape layers. 

 

In Photoshop, it is the vector shapes and points that are used to trace original artwork 

from sketches or Photographs. One advantage of vector graphics is that the colours are based 

on fill and gradient effects. In this sense there can be change of colour fills at any point in 

time. In his opinion on vector images Laybourne (1998) suggests: 

 

Another way to create a computer graphic is by treating it as a discrete 

object that the computer generates from data stored as a mathematical 

equation. Vector images (also known as object-oriented graphics) are 

created with what are called draw programmes. The benefits of working 

with vector images are that crisp appearance is retained if one changes the 

object‟s size. Also draw programs can make it easy to move images 

around independently. 

 

  This above submission is true because vector shapes can be likened to elastic shapes 

which can be altered at will to form another shape. Vectors are made up of points, lines, 

shapes, and so on. Von Alten (2007), reiterates on vector graphics. She writes: 

Vector graphics are made up of lines and curves defined by mathematical 

objects called vectors. These graphics retain their crispiness weather they 

are moved, resized or have their colour changed. Vector graphics are 

appropriate for illustration, type and graphics such as logos that may be 

scaled to different sizes. 

 

All graphic programs have text tools. Text tools are used to generate typefaces onto 

workspace. Types in their whole are vector forms, which is an element of traditional and 

digital art and design. “Vector graphics formats are complementary to raster graphics which 

is the representation of images as an array of pixels, as it is typically used for the 

representation of photographic images, (wikipedia.org 2010). Speaking on the usefulness of 

vector illustration, Goldman (2007) enumerates:  

  

 “It is no great accident that vector illustration is currently one of the 

trendiest and easily recognisable of the digital art disciplines. The 

signature flat colours and clean lines are easy to spot and quick to grab 

attention, which of course makes the style hugely popular with advertisers 

looking to catch the eye of potential consumers. In addition, their reduced 

colour palettes and scalable technology means they are perfect when it 

comes to artwork for the Web.” 

 

This proves that digital illustration is a prevailing style globally. Programmes 

associated with vector graphics are: Macromedia Freehand, Adobe Illustrator (AI), 

CorelDraw (CDR), Xara Extreme among others. It is believed that Raster graphics is more 

common than vector graphics.  

Data like sketches and photos put onto the workspace via scanners and digital 

cameras appear in form of Raster. This is because they are made up of picture elements 

(pixels) that embody the whole data. It is only in Raster file format that pixels are seen. Some 
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programs for illustration combine both Raster and vector effects. It is as easy as scanning 

ones object onto the workspace, applying pixel colours using raster art brushes and on the 

other hand, using primitive lines and shapes to juxtapose them with the Raster Image. Note 

that the primitives, consisting of lines and shapes are vector images. 

Apart from illustrations, the shapes and texts we use in creating designs on a given 

workspace are vectors. Vector illustrations can be easily converted to Raster or Bitmap form 

through “export” command or “save as” command. This command allows for a copy to be 

saved as Bitmap, leaving the original vector illustration in its location. Some programmes 

convert raster illustrations to vector. Take for instance, the conversion of a high resolution 

raster picture to vector. This is not really encouraging for it will make the job loose quality 

and detail, allowing one to work on the given object as vector file. Such effect is only best for 

line drawings and technical illustrations. Programmes like Corel X3, X4 and X5 have the 

qualities of converting Raster (Bitmaps) to Vector. To do this, scan your drawing in Black 

and white or Grayscale, or import your image onto your workspace. Click on the picture, go 

to bitmap on the menu bar, on the pop-up menu select quick trace, centerline trace or 

technical illustration and see the result. 

 

Bitmap Graphics 

Bitmap is another form which computer illustrations appear in. It is also known as 

Raster graphics. Pixel or picture element in full is the basic phenomenon in raster illustration 

Bitmaps or raster graphics are made up of square dots per inch (dpi). Those dots with varying 

tones make up raster images which includes Photographs. The dpi is the element that makes 

up pictures or other graphic in that form. Picture elements are sometimes called resolution. In 

view of this Laybourne (1998), further enunciates; 

The computer screen is actually composed of tiny dots called pixels. They 

are exactly seventy-two pixels in a square inch of computer screen 

resolutions. One way to create an image is delineating a patch of pixels – 

maybe a thin line or maybe a solid shade of colours – that is known as 

bitmap.  

As soon as photographs or line drawings are scanned onto a layout, it is converted to pixels. 

The square dpi can be visible when level increases up to 70 percent zoom. Von Alten (2007), 

in her description of bitmap graphics and its properties hints: 

Bitmap images, technically called raster images, are based on a grid of 

colours known as pixels.  Each pixel is assigned a specific location and 

colour value. In working with bitmap images, you edit groups of pixels 

rather than objects or shapes because bitmap graphics can represent 

subtle gradations of shade and colour, they are appropriate for continuous 

images such as photographs or artwork created in painting programs. 

 

Working with digital pen, ink and eraser involves bitmap because when one is adding 

colour via airbrush or pencil, dots that make up the image are added. On the other hand when 

part of the painting is wiped via the eraser tool, pixels making the image up are in turn erased. 

Affirming pixel as backbone of Bitmap or Raster illustration, An article on Raster Graphics 

in Encarta Encyclopedia (2009) further views that “Pixel, in computer science, short for 

picture element; is sometimes called a Pel.” One spot in a rectilinear grid of thousands of 

such spots that are individually “painted” to form an image produced on the screen by a 

computer or on paper by a printer. Just as a bit is the smallest unit of information a computer 

can process, a pixel is the smallest element that display or print hardware and software can 

manipulate in creating letters, numbers, or graphics. It is very understandable that 

photographic non vector illustrations contain millions of dots of tones, which are nearly very 
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tiny and less visible. These dots, which appear in various tones, are regarded as picture 

elements.  

 

Raster-based illustration programs are Adobe Photoshop, Paint Shop Pro, Corel 

Painter, Corel Paint Shop Pro, Microsoft Paint, Open Canvas, among others. This type of 

illustration is used consistently by professionals and widely for advertising and print designs 

as well. However the focus software in this study is Adobe Photoshop CS4. Goldman (2007) 

corroborates thus:  

  

Pixel art continues to gain momentum, with increasing numbers of 

advertising and editorial commissioners looking to capitalize on its retro 

style designs. The bold use of colour and scrutinizing detail also make it 

ideal for clients wishing to attract close attention and its popularity shows 

no signs of slowing. 

 

With this, it is noted that in as much as Ad professionals and artists are using vector 

art technique, many are also using bitmap technique for illustrations too. It is a question of 

preference. Bitmaps technique can be used to make digital paintings of portraits, landscapes 

and any other form the artist chooses.  

 

 

Adobe Photoshop Cs4 

Of the numerous vector and bitmap illustration suites available in the software 

market, Adobe Photoshop version CS4 has been selected for this study. Not that there are not 

lesser versions of Photoshop, but this one particularly have special rendering and filter 

effects, brush and window arrangement that will give the artist versatile opportunity to work 

out beautiful illustrations. 

Adobe Photoshop is a program powered by Adobe Incorporated, an American 

Software producing company. Norr (2010) in his article situates that “the Company was 

founded in1982 by John Warnock and Charles Gesshke”. The Adobe Incorporated, when 

fully functional had business ties with apple inc. Apart from software programming they also 

manufactured postscript typefaces that were used for desktop publishing then. According to 

Norr (2010): 

The first application introduced in 1987, was Adobe illustrator, a 

postscript-based drawing package for artists, designers and technical 

illustrators. Adobe Photoshop, an application for retouching digital images 

followed three years later and quickly became Adobe‟s most successful 

program. There are many other programmes introduced by Adobe-namely: 

Premiere, for video editing, Aftereffects, Acrobat for reading PDF 

document formats and so on. PDF means portable document format. It is a 

format for a computer document file that enables a document to be 

processed and printed on any computer using any printer or word-

processing program. 

 

The first version of the program Adobe Photoshop became functional in 1990. The 

program was aimed at aiding artists to create and produce high-end photographs for print 

and advertising purposes. Before 1993 drawing and painting tools were included in the 

program, which made Photoshop versatile. Students and Artists who had opportunity in the 

foreign countries utilized the golden opportunity and began experiments with the program. It 

took so many Photoshop Artists like Derek Lea, Mark Hamburg and Thomas Knoll and 

others, series of trial and error experiments, before they arrived at great findings that 
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changed the face of digital art and design forever. As Photoshop continued to develop, the 

programmers added more tools as the versions changed. That made Photoshop more 

sophisticated, making job outputs by the artists richer. Otaka (2008) in his view describes 

Photoshop and its possibilities for creativity. He says: 

 

Photoshop as it is fondly called is a professional image-editing 

application. Adobe Photoshop delivers a comprehensive environment for 

professional image-editing. With its integrated web application, Adobe 

Photoshop delivers a comprehensive environment for professional 

designers and graphics producers to create sophisticated images for print, 

web, wireless devices and other media. 

 

As a result of many years experience with Photoshop, the Nigerian artist declares and 

affirms its unlimited creative possibilities it can offer artists. This is because he has carried 

out experiments for Photo editing and special effects, which yielded surprising results. The 

decision to make catchy, communicative and beautiful designs lie within the artists‟ creative 

horizons. Otaka (2008) further affirms that: 

With its comprehensive set of retouching, painting, drawing and web 

tools, Photoshop helps you complete any image-editing task efficiently. 

And with features like the history palette and editable layers effects, you 

can experiment freely without sacrificing efficiency.  

 

Photoshop is very effective for both image-editing and digital drawing and painting. 

The software has dominated the market over the years and is demanded popularly by artists, 

teachers and trainers in this field of study. This is because of its effectiveness and unlimited 

creative possibilities it offers the users. 

 

Some Nigerian artists got in touch with Photoshop in late 1990s, while many began 

their training and experiments in early Twenty-first century. Nigerian Artists were familiar 

with Photoshop 7.0, which was programmed and released into the market in 2002. Interest 

rose amongst artists, Ad practitioners, art teachers and students. Since Photoshop 7.0 made 

its appearance, many of them dropped and failed to grab the opportunity to master this tool. 

Many artists that mastered Photoshop only embark on Photo editing, ignoring vector and 

raster illustration art techniques provided by the tool – Adobe Photoshop. The techniques for 

achieving digital drawing and painting, illustration and designs are technical in nature, but 

are not difficult to master. It may take time though.  

 

Igbo Folklore 

Folklore according to Encarta dictionary is a “traditional story that is passed down in 

a community or a country.”  In Igbo Society, folklore has been a notable norm amongst the 

people; it was part and parcel of the society, therefore a heritage of the Igbo people. Folktales 

dwelt on oral traditions. This means that stories were transmitted orally from person to 

person, family to family, and even from one generation to another. Although most of the 

folktales were fables, they wallowed in fascinating experience of an average Igboman, but 

used expression of personification, hyperbole and metaphor to tell the tales. “The Igbo have a 

system of folk beliefs that explains how everything in the world came into being. It explains 

what functions the heavenly and earthly bodies have and offers guidance on how to behave 

toward gods, spirits, and one's ancestors.” (everyculture.com  2012). Okodo (2011), in his 

work writes that “folktales are incredible stories, they were not forged out of nothing. The 
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iota of truth is that people depict their environment in their literature, part of which is the oral 

form.” 

This is because popular animals, objects and things, which are represented in these 

stories, are found within. Example is the Tortoise, the Kolanut, the Palm Kernel and the birds, 

to mention a few. Tortoise is the most popular characters in the Igbo folklore. This is because 

it is believed to be clever, witty, and tricky. His actions spur readers‟ or listeners‟ interest in 

the stories about him. This is because he always deciphers ways of manipulating his subjects 

to maneuver his way to success. Okodo, (2000) has it that “There are so many stories 

involving Tortoise in these stories. Tortoise is the protagonist on whom the stories hinge”. 

Years ago, many of the folklore in the form of oral literature have been transformed 

into various written works. Contemporary Nigerian Artists like Uche Okeke, Chike Aniakor, 

Obiora Udechukwu, among many others, used Uli medium and other techniques to present in 

visual form many of these written aspects of folklores. Thus a lot of folklore publications 

with illustrations were made innate. 

Today, a lot of modern technologies have put art to new dimensions. That is why the 

study employs the use of Adobe Photoshop CS4, a digital draw and paint software, to 

experiment on vector and bitmap types of computer illustration, intending to immortalize a 

few of these folklore in large format prints. 

 

Digital Techniques for producing Igbo folk illustration 

In this section, A folktale selected from Ogbalu‟s study (as cited in Okodo 2000 p. 50) 

will be illustrated in visual form. The title is “The Tortoise and the Birds”. The story tells the 

adventure of Tortoise with the birds and how he had his back pieced-up. This is a very all-

the-rage Igbo tale that was transmitted orally from the past, until renowned Igbo scholars put 

it in literary form. Practical techniques for creating the selected folk illustration in Photoshop 

CS4 will be discussed. This technique is Scan and colour technique, otherwise known as 

digital painting. There are other illustration techniques: they are vector tracing with sketches, 

vector tracing with photographs, bitmap painting with tablet and mouse. Samples made by 

the researcher will be discussed and displayed in detail, starting from the scratch to the finish. 

Various digital tools and filter effects used for each step will be discussed. However, the 

technique that will be discussed fully is sketch, scan and colour, also known as painting. 

The first step to creating illustrations is Concept development. This is the broad 

principle affecting the theme of the work. Igbo folktales are highly imaginative, delving into 

the imagination of listeners. Every artist hypothetically has a different picture of each story. 

This concedes for free expression by the artist. It is believed that Tortoise is a trickster in 

nature. He embodies the category of humans that manipulate people to their own aim. 

Tortoise is both the hero and villain in folktales.  

 

Sketch, Scan and Colour 

There are various skills for creating illustrations digitally with Photoshop CS4, 

involving both vector and bitmap graphics. This is a flexible technique of producing 

illustration in Photoshop. Here the technique that will be explored is draw and paint. This 

technique involves applying digital colours direct on the layout with the sketches on it. The 

tools required here are swatches, art brushes, Feathering and Layering properties. First and 

foremost, bumpy and tangling sketches are scribbled on papers. This is regarded as concept 

development. 

  

Step 1 

I made sketches on paper using B series Pencil. Reason is so that I can easily erase mistakes 

and unwanted strokes from the pencil. Professionally it is called penciling. 
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Step 2 

I traced the work with pen and ink. This is also known as inking. This defines the 

drawings. I have used various points of the pen in one drawing to avoid monotony. The next 

step is the erasing of the pencil lines. It can also be done digitally, but I preferred to do it 

traditionally to save time. Layborne (1998:218) argues that   

It is much less time-consuming either to erase superfluous lines on the 

actual drawing paper or, even better, to return to the light table and retrace 

the drawing onto a fresh sheet of paper than to attempt clean up using a 

computer graphics application. Truth is, the eye and hand are faster at 

spotting and eliminating unwanted marks than computer will ever be. 

 

This is true because from experience I gained through creating this piece, it was faster using 

eraser to clean unwanted lines on the actual paper. 

 
 

Fig 1: Concept development and a sketch of Mbe the Tortoise 

 

 
 

Fig 2: Concept development and a sketch of the birds 
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Step 3 

I scanned onto Photoshop layout using a USB Laser Scanner. The best resolution for 

scanning drawings is between 250 to 300 dpi. To eliminate dirt, pencil marks and unwanted 

tones I scanned the drawing as Black and White. This is the fastest way of doing away with 

dirt. Secondly, I converted it to Grayscale. This is so because I cannot convert Black and 

White to Colour straight away. To convert to grayscale I went to Image>Mode>Grayscale. In 

order to convert it to RGB or CMYK mode, I went to  Image>Mode>RGB/CMYK.   

I already have a specific folder where I save my works. I created it by going to 

File>Save As>. Here I selected a location in the Hard disk and named it “Illustration Files”. 

This helped me to identify my folder every now and again I want to work. I understand how 

important it is to maintain order in arranging my files. This saved me time in accessing them. 

 

 
 

Fig. 3: Same sketch of tortoise now traced in detail with ink and cleaned with eraser, before 

scanning will commence.  

 

 

 

Step 4 

To proceed to the next level, I have to repair the leaks in the drawing. Leaks are space 

in the drawing that did not join with other lines in the drawing. Assuming I did not fill up 

once I used the magic wand tool to make a selection, it would have flowed to the part I did 

not want magic wand to be in. If I had not patched the leaks, once I filled colour it would 

have flowed into the portion I did not desire to fill with the same colour in that instant. To 

repair the leaks I click on the pencil tool in the Tool box, right-clicked on the Layout to 

change the point size of the brush. The leaks are always tiny; therefore, tiny point pencils are 

required for this. 
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Fig. 4 

During the sketch, the pen line did not enclose the Tortoise‟s eye. The result is that 

when I filled the skin, it passed through the hole into the eye, which is expected to have 

another colour. 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5 

 

The accurate enclosure of the open space in the eye results in proper definition of each shape 

and colour when the paint bucket tool is used to fill the spaces with colours. 

After repairing the leaks, I duplicated a copy of the drawing on the layer pencil box. It 

is simple; Layer pencil is situated in the down right corner of the screen, next to it are the 

Channels and Paths panels. I right-clicked on a space in the box to select „new layer‟,  I hit 

„enter‟ or clicked “Ok”. Now on the layer panel I saw two images. I renamed the above by 

double-clicking on the box with text “background 2”. As soon as I have renamed it, the next 

thing I did was to fill up the base colours or wash colour, using paint bucket tool. Using 

magic wand tool I selected the background and pressed “delete” key to remove the unwanted 

white space. This was useful when I wanted to superimpose the image against a different 

background or two.  

 

 

 
 

Fig. 6, after the joining of broken lines, fill the spaces with the desired colours. 

 

As soon as I filled up the base colour of the drawing I went ahead to mark out the 

dark tones, considering Chiaroscuro. This means that I had to determine the direction where 

light falls on the illustration. Once I did this, I clicked on the „magic wand‟ tool, I clicked  

individual parts of the drawing. I went to the tool box, picked the brush tool, went to the 
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brush options tool, set the quality to „colour burn‟ and sometimes „normal‟. I right-clicked on 

the workspace and set the size of the brush. Using the selected brush I went to the colour 

docker tool in the Swatch and picked the darker tone of the former colour filled as mid-tone 

on the drawings. I indicated my dark tones by shading parts of the selected jobs. 

 
 

Fig. 7, The Tortoise is given more depth by coloring the mid-tone part of the drawings. 

 

Once I have succeeded, the next thing is to apply the highlights part of the illustration. This 

effect will eventually make it Photorealistic because the difference between shade, mid-tone 

and light is clearly defined in the work. Using the magic wand tool, I right-clicked to deselect 

the selections for the shades and make new selections with same tool. I cicked on the first fill 

to select the mid-tones because I used soft brush to paint the shades, the selection will not 

make a distinguished pick. This means it will exclude the shades on selection.  

 
 

Fig. 8, Completed painting of the Tortoise with full chiaroscuro effect. 

 

 

Feathering means softening the edges of an object. After making the selections for the 

highlight, I used feather properties by right-clicking immediately on the mouse to pop-up a 
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menu for selections. I clicked feathering options and set the value to 6. The higher the feather 

value goes, the softer the feather, and vice versa. I hit „Enter‟ key of „ok‟ and then went to the 

colour docker tool (swatch) and selected white. White is preferable because it is the tint to 

every colour. It is also a neutral colour. In essence it blends with all other colours in the 

spectrum. I clicked on the brush tool and right-clicked on the work to reduce or increase the 

diameter of the brush, also the flow. I set the opacity value of the brush pressure to 20 percent 

on the tool options bar and started painting on the selection. I saved the work continuously by 

going to File>Save, Ctrl + S on the keyboard as I progressed. 

 Because the theme of the work suggests famine, I believe there should be visual 

insinuation of drought in the story. In view of that I created texture that suggests crack effect 

for the soils in the animal kingdom, using brushes, gradients and colours on the photoshop 

layout.   

 

 
 

Fig 9: Texture created for the soils in the animal kingdom , using digital brush and colours on 

Photoshop Cs4. This  texture suggests drought 

 

 
Fig. 10: Same texture squashed to suggest depth and to fit the environments that have the 

illusion of third dimension. This suggests drought. 

 

 

As soon as the foreground illustration is ready, the next step is superimposing it 

against a background. I opened my picture, in form of Vector or pixels. I minimized the 

windows I am working on. I selected the Move tool in the Tool box, clicked and draged the 

background object from its window onto the window of finished illustration. Once it is done, 

I went to the layer property box on the down right corner of the screen and draged the 

background layer I imported below the illustration. This move now pushes the object below 
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the illustration. I altered the colour effects of the Background to suit my drawing, and I 

superimposed more objects on my background. At this level I considered the combination of 

vector and Pixels on the Layout. 

 

 
 

Plate 1: Complete Scene 2 of tortoise and the birds. 

 

Initially I saved my file as PSD, meaning Photoshop documents. As soon as I 

finished, I saved a copy of my file as JPEG, meaning Joint Photographic Expert Group. This 

Format is accepted by many other programmes, printers and even the web. For large format 

printing, JPEG and TIFF formats are used simultaneously. PNG (Portable Network Graphics) 

is an amiable format for online files. This is because the image is compressed from 

megabytes to bytes, to allow for easy upload and download of images in the cyberspace. 

 

 

Keyboard Shortcuts in Adobe Photoshop 

Keyboard shortcuts are commands that are used to give instructions to software 

instead of using the mouse to pick and click on the screen. The advantage is that it makes 

work fast, thereby saving a great deal of time in creating designs. Below are basic shortcut 

keys in Photoshop; 

 

Ctrl + N – New workspace, Alt + Ctrl + Shift + O – Open As, Ctrl + O – Open saved file, 

Ctrl + alt +F,A - Save As, Ctrl + Alt S – Save, Shift + Ctrl + P - Page Setup, Ctrl + P – Print, 

File Info – Alt + Shift + Ctrl + I, Keyboard shortcuts – Alt + Shift + Ctrl + K, Undo - Ctrl + 

Z, Step Backward – Alt + Ctrl + Z, Step Forward, Shift + Ctrl + Z, Menus – Alt + Shift + Ctrl 

+ M. There are various key shortcuts in Photoshop CS4, which are in every option I highlight 

from the menu bar. 
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Tool Keys 

G – Fill tool, Gradient shade tool. B – Brush tool, pencil tool. W – Magic wand tool. 

L – Lasso tool. X – Foreground/Back ground Colour. V – Move tool. C - Crop and Slice 

tools. I - Eyedropper tools, Ruler and sampler tools. J – Red eye, healing brush tools. S – 

Clone Stamp tools. H – History brush tool. E – Eraser tool. O – Dodge, burn and sponge 

tools. P – Pen tools. T – Horizontal and vertical type tools. A - Path Selection tools. U - 

Custom shape tools. H – Hand Tool. 

All these tools in one way or the other are used on the workspace to achieve desired effects. 

 

 

 

Restricting Flaws in the use of Photoshop for Illustration Design 

In as much as there are vast creative possibilities in Photoshop that artists explore, 

there are problems facing them too. It takes time to master the usage of digital tools in 

Photoshop and unfortunately, not very many artists are patient enough to sit tight and get 

used to the tools. To this end it bores beginners, more especially when creative results are yet 

to come out. Painting in Photoshop is not as flexible as in actual canvas and paper where 

artists use brushes and other tools to illustrate and express their radical feelings direct on the 

layout. The brush work done by use of mouse, tablet and light pen, etc for illustration is not 

exactly accurate since its application is indirect and will never give the artist the feeling of 

controlling the movement of the brushes as with his hands. There is difficulty to working 

with bitmaps because the pixels or dpi of certain images are limited. Once the image is scaled 

or expanded, it will try to maintain the same resolution in the large format. This will make the 

image to lose details.  
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Visual Discussion of “Tortoise and the birds”, based on Ogbalu in Okodo (2000; 50) and 

the artist’s imagination. 

 

SCENE 1 

 
 

Plate 2, Title: Famine, Medium: digital illustration, Size: 36*24 in, Date: 2012, Artist: Chidi 

Onwuekwe. 

 

“Once Upon a time in the kingdom of animals, there was drought, dearth and famine. There 

was neither food nor drink. As a result, hunger and starvation arose.” Here I suggested 

drought with the texture of dry soil painted with Photoshop brushes. The skull, dead animals 

and dry shrubs in the background show that life is deteriorating. 

 

SCENE 2 

 
Plate 3,Title: Umu Nnunu, Medium: digital illustration, Size: 36 x 24 in, Date: 2012, Artist: 

Chidi Onwuekwe. 

 

 “The birds had a place the go to feed – the sky. They are the only animals that were 

unaffected by the raging drought and famine.” I used predominantly bright colours on most 

of the birds, considering that most birds in nature have beautiful colours. 
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SCENE 3 

 
Plate 4, Title: Tortoise appears, Medium: digital illustration, Size: 36*24 in, Date: 2012, 

Artist: Chidi Onwuekwe. 

 

“Hungry stricken tortoise appeared in the scene and pleaded with the birds to take him along 

to wherever they fed so he would live long. Here I purposefully made the shell of tortoise 

smooth, because the theme of the story portrayed how tortoise had cracked shell. 

 

SCENE 4 

 
Plate 5, Title: Tortoise gets wings, Medium: digital illustration, Size: 36 x 24 in, Date: 2012, 

Artist: Chidi Onwuekwe. 

 

“Here, after convincing the birds to trust him, they lent him wings. Tortoise appears beautiful 

and attractive. He enthused with happiness and became talkative.” 
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SCENE 5 

 
 

Plate 6, Title: Mbe the talkative trickster, Medium: digital illustration, Size: 36 x 24 in, Date: 

2012, Artist: Chidi Onwuekwe. 

 

“Because of loud and talkative nature of the tortoise, he was made the spokesman of the 

birds. He named himself YOU ALL.” 

 

SCENE 6 

 
Plate 7, Title: Flight to the sky, Medium: digital illustration, Size: 36 x 24 in, Date: 2012, 

Artist: Chidi Onwuekwe. 

 

“After the lending of wings to the trickster and intense pact of trust between tortoise and the 

birds, they flew to their place of feast in the sky, where the dwellers have their tables full of 

goodies.” 
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The efforts by the artist to produce the sixth scene to the 15
th

 scene in the studio are in 

progress. By the end all the 15 illustration will be portrayed, in visual form, in the new digital 

media, using Adobe Photoshop Cs4. 

 

 

Recommendations 

In view of the steps trailed in producing some Igbo folk illustration on Photoshop 

workspace, the study will recommend necessary actions to be taken by various authorities 

responsible for institutions of high learning. One of the recommendations is to give digital 

illustration a proper place in the academic curriculum. If the curriculum is revisited, some of 

these trends should be infused into the system. Authorities in Universities and Polytechnics 

should ensure the provision of up to date computer systems. This will urge the students in art 

schools to experiment on these techniques. The study, if perused meticulously, will also 

provide general information that will fortify beginners guide to digital illustration art with 

Photoshop CS4, particularly the draw and paint technique.  

 

 

Conclusion 

There is the need to foster, further, advance, cultivate, forward, and encourage Igbo 

values using diverse modern means. This is the motivation of this essay, which concentrated 

on digital technique of creating illustration, in the form of draw and paint, using Adobe 

Photoshop CS4 software. Draw and paint technique, which involves sketch, inking and scan, 

was used. Enclosure of spaces of lines forming objects was done using digital pen. This 

prevents the flow of colour into another place that needs other colour. Flat fills, mid tones and 

highlight painting follow after. Special effects in Photoshop Cs4 are of great help towards 

rendering the illustrations to appear photorealistic. All the said and done above were used to 

create 15 illustration scenes, in large format digital prints, based on the story of Ogbalu, (as 

cited in Okodo 2000 p. 50). These digital prints narrate pictorially the famous folktale of 

Tortoise and the birds in the animal kingdom, during a long period of draught and famine. 

This research not only makes available the practical steps to create draw and paint type of 

illustration on Photoshop, it enshrines the popular folk tale in visual form, using 21
st
 century 

trend in illustration. This work is also thrown open for usage by further researchers in this 

field.   
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